This document is provided with the BOOST-DRV8711 Stepper Motor BoosterPack as a supplement to the DRV8711 datasheet (SLVSC40) and CSD88537ND datasheet (SLPS455) to detail the hardware setup and operation of the BoosterPack.

Contents

1 BOOST-DRV8711 Views ................................................................. 2
2 Introduction to the BOOST-DRV8711 .............................................. 3
  2.1 Features ................................................................................. 3
  2.2 Pinout .................................................................................. 3
3 Getting Started ............................................................................ 4
  3.1 Requirements ....................................................................... 4
  3.2 Configuring the LaunchPad ..................................................... 4
  3.3 Connecting the Hardware ...................................................... 5
4 Stepper Motor Demo Application .................................................... 6
  4.1 Introduction .......................................................................... 6
  4.2 Setting up the BOOST-DRV8711 Firmware .......................... 6
  4.3 Setting up the BOOST-DRV8711 GUI .................................. 9
  4.4 Spinning Your Stepper Motor ............................................... 10
5 Hardware Files (Schematic/Gerber) ............................................... 12

List of Figures

1 BOOST-DRV8711 Stand-Alone .................................................... 2
2 BOOST-DRV8711 on MSP-EXP430G2 ...................................... 2
3 BOOST-DRV8711 Pinout ............................................................ 3
4 MSP-EXP430G2 Jumper Location .............................................. 4
5 Target Configuration ................................................................. 6
6 Target Configuration Setup ....................................................... 7
7 Launch Selected Configuration .................................................... 7
8 Connect Target Selection ........................................................... 8
9 Load Program Selection ............................................................. 8
10 Existing CCS Eclipse Projects .................................................. 9
11 BOOST-DRV8711 GUI Screen ................................................ 10
12 BOOST-DRV8711 GUI CONTROL Tab ................................... 11
13 BOOST-DRV8711 GUI REGISTERS Tab .................................. 12
1  BOOST-DRV8711 Views

The views in Figure 1 and Figure 2 are of the BOOST-DRV8711 Stepper Motor BoosterPack.

Figure 1. BOOST-DRV8711 Stand-Alone

Figure 2. BOOST-DRV8711 on MSP-EXP430G2
2 Introduction to the BOOST-DRV8711

The BOOST-DRV8711 is a stepper motor BoosterPack based on the DRV8711 Stepper Motor Controller and CSD88537ND Dual 60-V N-Channel NexFET™ Power MOSFETs. This BoosterPack provides a complete stepper motor drive stage in order to evaluate your motor applications.

2.1 Features

• Complete stepper motor drive stage in a small form factor (1.75 in × 2.00 in)
• Supports 8.2–52 V and up to 4.5 A continuous for each H-Bridge
• 4x CSD88537ND Dual 60-V N-Channel NexFET Power MOSFETs (12.5 mΩ)
• Motor stall and device fault LED indicators
• Fully protected drive stage including overcurrent, overtemperature, undervoltage, and motor stall detect
• Combine with TI LaunchPad kits to create a complete stepper motor drive and control platform
• Optimized for the MSP-EXP430G2 LaunchPad with a user-friendly application to get your motor spinning in minutes

2.2 Pinout

The BOOST-DRV8711 brings out a mixture of power, control, and feedback signals to the LaunchPad headers.

- Powered by an external power supply (8.2–52 V) that can be connected to the terminal block header (J6)
- 4-pin terminal block header (J5) for connecting a bipolar stepper motor
- Fault and motor status reporting through the nFAULT and nSTALL signals
- SPI interface to set device configuration, operating parameters, and read out diagnostic information
- Built-in microstepping indexer through a STEP/DIR interface or H-Bridge control through an IN/IN interface
- Onboard potentiometer for creating your own, easy-to-use, demo application
3 Getting Started

3.1 Requirements

The Stepper Motor BoosterPack is not a standalone evaluation board and requires a compatible LaunchPad kit to provide the appropriate control signals. In addition to the Stepper Motor BoosterPack and a compatible LaunchPad, a stepper motor and sufficient power supply are required.

3.2 Configuring the LaunchPad

3.2.1 Example Using MSP-EXP430G2

For the MSP-EXP430G2 LaunchPad, remove the P1.0 and P1.6 (LED1 and LED2) jumpers for correct operation of the POT and SDO signals of the BoosterPack. The TXD and RXD jumpers should be aligned horizontally (black rectangles in Figure 4) for operation of the hardware UART with a software application.

![Figure 4. MSP-EXP430G2 Jumper Location](image)

For other LaunchPads, ensure that the appropriate jumpers are configured on pins that the BOOST-DRV8711 BoosterPack utilizes.
3.3 Connecting the Hardware

1. Plug the Stepper Motor BoosterPack onto the LaunchPad as shown in Figure 2. The terminal block headers should be oriented towards the USB connector.

2. Connect your stepper motor to the terminal block header J5. The motor should have two windings, each with a + and a – termination. Connect one winding to A1/A2 and the other to B1/B2 (polarity does not matter). For questions on the motor wire coloring coding, please see the motor’s datasheet.

3. Connect the power supply that will power the Stepper Motor BoosterPack’s DRV8711 and Drive Stage to the terminal block header J6. The connections have been labeled VM and GND. For full performance, ensure you can supply as much current as your motor may demand. The Stepper Motor BoosterPack has a designed operating range from 8.2–52 V up to 4.5 A continuous for each H-Bridge.

WARNING
At high currents the drive stage can increase to high temperatures

4. Enable the power supply

5. Enable your controller and spin the motor. The BOOST-DRV8711 Stepper Motor BoosterPack combined with a TI LaunchPad provides a complete stepper motor evaluation platform. With the MSP-EXP430G2 LaunchPad and a MSP430G2553 you can take full advantage of TI's pre-written stepper motor control application (see Section 4 for additional details).
4 Stepper Motor Demo Application

4.1 Introduction

As mentioned earlier, the BOOSTXL-DRV8301 Motor Drive BoosterPack has been optimized to work together with the MSP430G2 Launchpad, MSP-EXP430G2, and MSP430G2553 to provide a complete stepper motor evaluation platform. With the demo application provided, you can have your stepper motor up and spinning in minutes. Get started with TI’s pre-written stepper control application by following the steps outlined in Section 4.2 through Section 4.4.

4.2 Setting up the BOOST-DRV8711 Firmware

1. Download the latest version of Code Composer Studio to load the BOOST-DRV8711 stepper motor control application onto the MSP430G2553. The application was developed in CCS v5.5.0. 

2. To obtain the BOOST-DRV8711 firmware and GUI, download the BOOST-DRV8711 Hardware and Software Files from the tool folder, http://www.ti.com/tool/boost-drv8711. This zip folder contains the complete hardware design files, including the Altium source files, Gerbers, BOM, schematic, as well as the Stepper Motor Demo firmware and GUI.

3. Flash the MSP430G2553 on the MSP430G2 LaunchPad with the firmware provided. This will require the MSP430G2 LaunchPad, a MSP430G2553, Mini USB cable, and can be done in one of two ways which are outlined in Step 4 and Step 5.

4. Method 1: Loading the binary .out file
   • Open Code Composer Studio.
   • Select View → Target Configuration (Figure 5, left side of image)
   • Right click on the User Defined folder and select New Target Configuration (Figure 5, right side of image)

   ![Figure 5. Target Configuration](image)

   • Give the Target Configuration a name and select Finish
   • Figure 6 illustrates how the Target Configuration should be set up. Save the Target Configuration file.
Figure 6. Target Configuration Setup

- Go back to View → Target Configurations
- Right click your newly created Target Configuration file and select Launch Selected Configuration (Figure 7)

Figure 7. Launch Selected Configuration

- In the Debug Menu, right click on the TI MSP430 USB1_0 connection and select Connect Target (Figure 8)
After the device connects, go to Run → Load → Load Program (Figure 9). Browse to the BOOST-DRV8711 Hardware and Software Files folder that was downloaded from the tool folder. Go into the Application subdirectory and then go into the GUI subdirectory. Select the appProgram.out file (Application\BOOST-DRV8711_GUIvX.X\appProgram.out).

After a short delay, the appProgram.out file is loaded onto the MSP430G2553

Close CCS

5. Method 2: Flashing the project through CCS debugger

• Open Code Composer Studio
• Go to File → Import
• Select **Existing CCS Eclipse Projects** under the **Code Composer Studio** tab (Figure 10)

![Figure 10. Existing CCS Eclipse Projects](image)

- Check the **Copy projects into workspace** option and then browse to the **BOOST-DRV8711_FIRMWAREvX.X** directory located within the Application folder within the **BOOST-DRV8711 Hardware and Software Files** folder. The project should now show up in the **Discovered Projects** section. Ensure that it is checked and select **Finish**.
- Select the **BOOST-DRV8711_FIRMWAREv1.0** project in the **Project Explorer** and click the **Debug** icon.
- CCS will now build the project and load it onto the MSP430G2533.
- Close CCS.

### 4.3 Setting up the **BOOST-DRV8711 GUI**

1. Download the latest version of the GUI Composer Runtime to initially run the **BOOST-DRV8711 GUI**. You must register for a TI account if you don’t already have one. Select the appropriate version for your operating system and follow the install instructions.

2. After installing the GUI Composer Runtime, copy the **BOOST-DRV8711_GUIvX.X** folder, located in the Application directory of the **BOOST-DRV8711 Hardware and Software Files** folder and paste this folder into the GUI Composer webapps folder located in the `C:\ti\guicomposer\webapps\` directory. **(Note: if you chose a non-default installation directory in Step 1, the top-level directory may differ)**

3. To run the GUI, double click the **BOOST-DRV8711_GUIvX.X.exe** file within the **BOOST-DRV8711_GUIvX.X** folder of the webapps directory. You can make a shortcut to this .exe in order to start it from other file locations.

   **Ensure that the GUI “exe” is exactly two levels below the GUI Composer “webapps” folder. The GUI will not start if this is incorrect. The path should look similar to this**
   `C:\ti\guicomposer\webapps\BOOST-DRV8711_GUIvX.X\BOOST-DRV8711_GUIvX.X.exe`.
   **(Note: if you chose a non-default installation directory in Step 1, the top-level directory may differ)**
4.4 Spinning Your Stepper Motor

After a successful launch of the BOOST-DRV8711_GUIvX.X.exe, Figure 11 pops up. It may take a small period of time before the GUI connects and the GUI Widgets populate (red X’s appear on the widgets while the GUI is connecting). If the GUI does not load after a few minutes (the X’s disappear), a connection issue may have occurred and TI recommends restarting the application.

Figure 11. BOOST-DRV8711 GUI Screen

4.4.1 Quick Start

1. Set Your Full Scale Current level appropriately by adjusting the TORQUE and ISGAIN settings. Your Full Scale Current level is determined by your stepper motor’s current rating and power supply capability. Click the Set All button after choosing the appropriate settings.

2. Select your Step Mode. This determines the level of microstepping applied to the motor.

3. Set the nSLEEP pin high to bring the DRV8711 out of sleep mode. The DRV8711 now begins regulating current.

4. Adjust the Stepper Motion Profile parameters to the desired values. The units are Pulses Per Second, otherwise known as Steps Per Second.

5. Enable the Speed Profile or Step # Profile button depending on the desired mode.

The BOOST-DRV8711 GUI provides two tabs. The first tab controls the Stepper Motor and the second tab sets the registers of the DRV8711.
4.4.2 CONTROL Tab Walkthrough

1. The nSLEEP and RESET buttons directly control the nSLEEP and RESET pins of the DRV8711. Red indicates LOW (0 V) and green indicates HIGH (3.3 V). nSLEEP = LOW puts the DRV8711 in a low power sleep mode. RESET = HIGH resets the internal logic and disable the H-bridge outputs.

2. The STEP and DIR buttons give you command of the stepper motor. STEP moves the motor one step, independent of the Stepper Motion Profile. DIR selects which direction the motor is spinning.

3. The Stepper Motion Profile provides a method to spin the stepper motor in a variety of ways. It gives you command of the starting/stopping speed, acceleration rate, target speed, and number of steps (if using the step # profile). The units are pulses per second, or steps per second, as the DRV8711 will move a step with every rising edge it sees.

4. The Speed Profile button (once selected) accelerates the stepper motor from the starting speed to the target speed. The motor remains at this speed until the Speed Profile button is selected again. The Step # Profile (once selected) moves the stepper motor the specified number of steps while attempting to maintain the speed profile. Due to approximation errors on the MCU, the target speed may not exactly match the target speed.

5. The nFAULT and nSTALL provide status about the motor and motor driver. The nFAULT reports on a variety of faults for the DRV8711. A more detailed description of the various faults can be found in the datasheet. nSTALL is a feature of the DRV8711 to detect a motor stall. This feature must be calibrated to function properly. Please see the datasheet for additional information.

6. The Current Speed box provides information about the current speed of the speed motor. The Motor State box indicate the status of the motor, whether it is stopped, accelerating, decelerating, and so forth. Note that there is a slight time delay in the GUI (~ 1 second).

7. The Step Mode setting determines the microstepping level of the DRV8711. The Decay Mode determines the decay method of the current regulation scheme. The recommended modes for stepper motors are All Mixed and Auto Mixed Decay. The decay method is fine tuned in the Registers tab.

8. The TORQUE and ISGAIN settings, in combination with the hardware SENSE resistor, determine the full scale current of the current regulation scheme. By adjusting these settings you can adjust the full

---

Figure 12. BOOST-DJV8711 GUI CONTROL Tab
scale current level appropriately for your specific motor. Refer to the datasheet for the exact formula for full scale current.

9. The Set All button takes the settings in the GUI and writes them to the DRV8711. Click this button to update the DRV8711 once you have made the desired settings.

4.4.3 REGISTERS Tab Walkthrough

![Figure 13. BOOST-DRV8711 GUI REGISTERS Tab](image)

1. The BOOST-DRV8711 GUI provides access to all of the register settings of the DRV8711. Use this page to fine tune the motor driver settings. The register name as well as its hexadecimal address is shown. Refer to the DRV8711 datasheet (SLVSC40) for a more detailed description of each setting.

2. The Reset Faults button resets any faults that have occurred while driving your stepper motor. If a fault occurs while spinning your motor (FAULT LED lights ups), select this button to clear the fault. Selecting the button only clears the fault if the fault condition has been removed. Please refer to the DRV8711 datasheet for a detailed description of possible fault conditions.

3. The Manual SPI Read/Write section allows you to manually read or write hexadecimal values to the DRV8711.

4. The Write All button updates the DRV8711 with the values set in the GUI. The Read All button updates the GUI with the values from the DRV8711.

5 Hardware Files (Schematic/Gerber)

The complete design files are found in the tool folder (http://www.ti.com/tool/boost-drv8711) including the schematic, Gerbers, layout files, PCB views, and bill of materials.
ADDITIONAL TERMS AND CONDITIONS, WARNINGS, RESTRICTIONS, AND DISCLAIMERS FOR EVALUATION MODULES

Texas Instruments Incorporated (TI) markets, sells, and loans all evaluation boards, kits, and/or modules (EVMs) pursuant to, and user expressly acknowledges, represents, and agrees, and takes sole responsibility and risk with respect to, the following:

1. User agrees and acknowledges that EVMs are intended to be handled and used for feasibility evaluation only in laboratory and/or development environments. Notwithstanding the foregoing, in certain instances, TI makes certain EVMs available to users that do not handle and use EVMs solely for feasibility evaluation only in laboratory and/or development environments, but may use EVMs in a hobbyist environment. All EVMs made available to hobbyist users are FCC certified, as applicable. Hobbyist users acknowledge, agree, and shall comply with all applicable terms, conditions, warnings, and restrictions in this document and are subject to the disclaimer and indemnity provisions included in this document.

2. Unless otherwise indicated, EVMs are not finished products and not intended for consumer use. EVMs are intended solely for use by technically qualified electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.

3. User agrees that EVMs shall not be used as, or incorporated into, all or any part of a finished product.

4. User agrees and acknowledges that certain EVMs may not be designed or manufactured by TI.

5. User must read the user's guide and all other documentation accompanying EVMs, including without limitation any warning or restriction notices, prior to handling and/or using EVMs. Such notices contain important safety information related to, for example, temperatures and voltages. For additional information on TI's environmental and/or safety programs, please visit www.ti.com/esh or contact TI.

6. User assumes all responsibility, obligation, and any corresponding liability for proper and safe handling and use of EVMs.

7. Should any EVM not meet the specifications indicated in the user's guide or other documentation accompanying such EVM, the EVM may be returned to TI within 30 days from the date of delivery for a full refund. THE FOREGOING LIMITED WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY TI TO USER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. TI SHALL NOT BE LIABLE TO USER FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RELATED TO THE HANDLING OR USE OF ANY EVM.

8. No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or combination in which EVMs might be or are used. TI currently deals with a variety of customers, and therefore TI's arrangement with the user is not exclusive. TI assumes no liability for applications assistance, customer product design, software performance, or infringement of patents or services with respect to the handling or use of EVMs.

9. User assumes sole responsibility to determine whether EVMs may be subject to any applicable federal, state, or local laws and regulatory requirements (including but not limited to U.S. Food and Drug Administration regulations, if applicable) related to its handling and use of EVMs and, if applicable, compliance in all respects with such laws and regulations.

10. User has sole responsibility to ensure the safety of any activities to be conducted by it and its employees, affiliates, contractors or designees, with respect to handling and using EVMs. Further, user is responsible to ensure that any interfaces (electronic and/or mechanical) between EVMs and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard.

11. User shall employ reasonable safeguards to ensure that user's use of EVMs will not result in any property damage, injury or death, even if EVMs should fail to perform as described or expected.

12. User shall be solely responsible for proper disposal and recycling of EVMs consistent with all applicable federal, state, and local requirements.

Certain Instructions. User shall operate EVMs within TI's recommended specifications and environmental considerations per the user's guide, accompanying documentation, and any other applicable requirements. Exceeding the specified ratings (including but not limited to input and output voltage, current, power, and environmental ranges) for EVMs may cause property damage, personal injury or death. If there are questions concerning these ratings, user should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the applicable EVM user's guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, some circuit components may have case temperatures greater than 60°C as long as the input and output are maintained at a normal ambient operating temperature. These components include but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors which can be identified using EVM's schematics located in the applicable EVM user's guide. When placing measurement probes near EVMs during normal operation, please be aware that EVMs may become very warm. As with all electronic evaluation tools, only qualified personnel knowledgeable in electronic measurement and diagnostics normally found in development environments should use EVMs.

Agreement to Defend, Indemnify and Hold Harmless. User agrees to defend, indemnify, and hold TI, its directors, officers, employees, agents, representatives, affiliates, licensors and their representatives harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, "Claims") arising out of, or in connection with, any handling and/or use of EVMs. User's indemnity shall apply whether Claims arise under law of tort or contract or any other legal theory, and even if EVMs fail to perform as described or expected.

Safety-Critical or Life-Critical Applications. If user intends to use EVMs in evaluations of safety critical applications (such as life support), and a failure of a TI product considered for purchase by user for use in user's product would reasonably be expected to cause severe personal injury or death such as devices which are classified as FDA Class III or similar classification, then user must specifically notify TI of such intent and enter into a separate Assurance and Indemnity Agreement.
RADIO FREQUENCY REGULATORY COMPLIANCE INFORMATION FOR EVALUATION MODULES

Texas Instruments Incorporated (TI) evaluation boards, kits, and/or modules (EVMs) and/or accompanying hardware that is marketed, sold, or loaned to users may or may not be subject to radio frequency regulations in specific countries.

General Statement for EVMs Not Including a Radio

For EVMs not including a radio and not subject to the U.S. Federal Communications Commission (FCC) or Industry Canada (IC) regulations, TI intends EVMs to be used only for engineering development, demonstration, or evaluation purposes. EVMs are not finished products typically fit for general consumer use. EVMs may nonetheless generate, use, or radiate radio frequency energy, but have not been tested for compliance with the limits of computing devices pursuant to part 15 of FCC or the ICES-003 rules. Operation of such EVMs may cause interference with radio communications, in which case the user at his own expense will be required to take whatever measures may be required to correct this interference.

General Statement for EVMs including a radio

User Power/Frequency Use Obligations: For EVMs including a radio, the radio included in such EVMs is intended for development and/or professional use only in legally allocated frequency and power limits. Any use of radio frequencies and/or power availability in such EVMs and their development application(s) must comply with local laws governing radio spectrum allocation and power limits for such EVMs. It is the user’s sole responsibility to only operate this radio in legally acceptable frequency space and within legally mandated power limitations. Any exceptions to this are strictly prohibited and unauthorized by TI unless user has obtained appropriate experimental and/or development licenses from local regulatory authorities, which is the sole responsibility of the user, including its acceptable authorization.

U.S. Federal Communications Commission Compliance

For EVMs Annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant

Caution

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. Changes or modifications could void the user’s authority to operate the equipment.

FCC Interference Statement for Class A EVM devices

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at its own expense.

FCC Interference Statement for Class B EVM devices

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Industry Canada Compliance (English)

For EVMs Annotated as IC – INDUSTRY CANADA Compliant:

This Class A or B digital apparatus complies with Canadian ICES-003. Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Concerning EVMs Including Radio Transmitters

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concerning EVMs Including Detachable Antennas

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.
Canada Industry Canada Compliance (French)
Cet appareil numérique de la classe A ou B est conforme à la norme NMB-003 du Canada
Les changements ou les modifications pas expressément approuvés par la partie responsable de la conformité ont pu vider l'autorité de l'utilisateur pour actionner l'équipement.

Concernant les EVMs avec appareils radio
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concernant les EVMs avec antennes déetchables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante.

Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2014, Texas Instruments Incorporated

Important Notice for Users of EVMs Considered “Radio Frequency Products” in Japan
EVMs entering Japan are NOT certified by TI as conforming to Technical Regulations of Radio Law of Japan.
If user uses EVMs in Japan, user is required by Radio Law of Japan to follow the instructions below with respect to EVMs:
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan,
2. Use EVMs only after user obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or
3. Use of EVMs only after user obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless user gives the same notice above to the transferee. Please note that if user does not follow the instructions above, user will be subject to penalties of Radio Law of Japan.

http://www.tij.co.jp

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】本開発キットは技術基準適合証明を受けておりません。本製品のご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。
なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿6丁目24番1号
西新宿三井ビル

http://www.tij.co.jp

Texas Instruments Japan Limited
(address) 24-1, Nishi-Shinjuku 6 chome, Shinjuku-ku, Tokyo, Japan
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Products

| Audio | www.ti.com/audio |
| Amplifiers | amplifier.ti.com |
| Data Converters | dataconverter.ti.com |
| DLP® Products | www.dlp.com |
| DSP | dsp.ti.com |
| Clocks and Timers | www.ti.com/clocks |
| Interface | interface.ti.com |
| Logic | logic.ti.com |
| Power Mgmt | power.ti.com |
| Microcontrollers | microcontroller.ti.com |
| RFID | www.ti-rfid.com |
| OMAP Applications Processors | www.ti.com/omap |
| Wireless Connectivity | www.ti.com/wirelessconnectivity |

Applications

| Automotive and Transportation | www.ti.com/automotive |
| Communications and Telecom | www.ti.com/communications |
| Computers and Peripherals | www.ti.com/computers |
| Consumer Electronics | www.ti.com/consumer-apps |
| Energy and Lighting | www.ti.com/energy |
| Industrial | www.ti.com/industrial |
| Medical | www.ti.com/medical |
| Security | www.ti.com/security |
| Space, Avionics and Defense | www.ti.com/space-avionics-defense |
| Video and Imaging | www.ti.com/video |
| TI E2E Community | e2e.ti.com |

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2014, Texas Instruments Incorporated